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TUTORIAL – Organizzare una gara di TrailO 

con TiM, Ant e Oribos            Remo Madella – versione Giugno 2020 

 

Questo documento costituisce una guida per tutti i tracciatori di gare TrailO. 

Verranno analizzati i comandi e le procedure principali dei programmi TiM (per la creazione automatica 

mappe per le gare di TempO e per stazioni a tempo delle gare di PreO), ANT (per la rilevazione da parte dei 

giudici dei tempi di risposta nei punti a tempo) e Oribos (per gestire iscrizioni e classifiche). 

 

 

1) TiM — Timed control map Maker  
CREAZIONE AUTOMATICA MAPPE PER STAZIONI TEMP-O 

sito > http://tim.yq.cz/ 

requisiti> PC con Windows. 

                 OCAD 9 Professional oppure  

                 OCAD10 Professional oppure 

                 OCAD 11 Professional oppure 

                 OCAD12 Standard 

In generale vanno bene tutte le versioni di OCAD che permettono l'esportazione in SVG. 

Fino a OCAD11 è richiesta la versione Professional (la Standard non esporta SVG). 

Anche la versione OCAD12 Course Setting va bene (permette esportazione SVG) e in questo caso si può usare 

come sfondo anche una mappa di OpenOrienteeringMapper. 

 

Sul sito è presente un forum in cui condividere esperienze e problemi. Il creatore del software Libor Forst 

(forst@ms.mff.cuni.cz) è sempre pronto ad aiutare in caso di problemi (il programma è in continua evoluzione 

quindi quello che funzionava in una versione potrebbe non funzionare nella versione successiva). 

 

TiM è un software che si installa su PC con Windows (no Mac) 

Scaricare il programma dal sito http://tim.yq.cz/ cliccando sull'icona in alto a destra nel sito (vedi foto) e 

installarlo sul PC. 

 

 
 

http://tim.yq.cz/
http://tim.yq.cz/


 
                        

 

 

 

Presidenza e Segreteria Generale: Via della Malpensada,84 - 38123 TRENTO 

Telefono +39 0461-231380 Web: www.fiso.it - E-mail: info@fiso.it 

P.IVA 00853510220 - C.F. 80023420229 
  
 

 

SAMPLE 

All'indirizzo  www.remmaps.it/trailo/dwnld/sample_ocad_cfg.zip  sono presenti dei file (.cfg e ocad9) con un 

esempio funzionante e tutti i settaggi/simboli descritti sucessivamente (testato con  la versione di TiM 4.1.10). 

 

PREPARAZIONE FILE OCAD 

Preparare un classico file dei percorsi OCAD (che chiameremo ad esempio prova.ocd), con scala 1:4000, con 

una mappa come sfondo (background). 

Il nome del file ocad è buona norma che non sia troppo lungo e che non abbia spazi o caratteri speciali (ad es. 

percorsi_monza è ok) 

Creare un percorso per ogni stazione; i percorsi si devono chiamare 1 2 3 etc etc. 

Non chiamare i percorsi con il numero 0 (zero). 

Nel file ocad devono essere presenti una partenza fittizia e anche un box della descrizione punti. Possono stare 

in qualsiasi posizione, con l'accortezza che rimangano tutti e due dentro l'area di esportazione SVG (vedi in 

seguito). 

La Partenza deve essere anche inserita in tutti i percorsi. Ad esempio, il percorso '1' (che riguarda la stazione 1) 

contiene la partenza e 5 punti di controllo: S1 31 32 33 34 35. (se vogliamo poi creare le soluzioni in modo 

automatico dovremo aggiungere altri punti speciali nel percorso – vedi in seguito) 

 

Quando i percorsi sono completi, verificato che la vista corrente sia in modo NORMALE, si devono effettuare  

due esportazioni: 

- esportare un file XML dei percorsi (Course>Export>Courses(XML) 

- esportare un file SVG, con l'accortezza di scegliere un'area di esportazione (mappa parziale) che comprenda 

oltre ai punti di controllo anche partenza, eventuale arrivo e tutto il box delle descrizione punto. 

Importante: deselezionare la compressione file. Selezionare i percorsi che si desidera esportare, in genere si 

esportano tutti (non usare 'Tutti i punti'). 

Per entrambe le esportazioni tenere i nomi dei file proposti da OCAD in default e salvare i files nella stessa 

cartella del file ocad. 

 

FILE .CFG TIM 

Aprire TiM e creare un nuovo file (File>New) 

Scegliere la cartella dove sono già presenti I file ocad, xml e svg. TiM riconosce i file e imposta già alcuni 

parametri. 

Salvando il file di TiM verrà creato un file 

.cfg che si potrà riaprire in TiM per le 

successive variazioni. Salvare il file ad 

esempio con il nome prova.cfg sempre 

nella stessa cartella di lavoro. 

 

La configurazione dei parametri di TiM si 

può quindi fare in due modi: nella finestra 

di configurazione sulla destra oppure (per 

utenti più esperti) con il programma chiuso 

editando direttamente il file .cfg 

(ovviamente dopo che è stato creato) in un 

qualsiasi editor di testo. 

Nella foto a lato si vede sulla destra la 

finestra di configurazione in TiM e sulla 

sinistra il file .cfg aperto con un editor di 

testo. Si riconoscono gli stessi campi. 

http://www.remmaps.it/trailo/dwnld/sample_ocad_cfg.zip
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CONFIGURAZIONE  TIM 

Nella finestra di configurazione in TiM per rendere effettive le modifiche bisogna avere l'accortezza di cliccare 

fuori da ogni cella dopo averla editata. Se il valore diventa grassetto ha preso la modifica. Inoltre, cliccando su 

ogni cella compare un piccolo help in inglese.  

 

Questi sono i parametri base da configurare per una gara standard, tutti gli altri parametri possono essere 

lasciati vuoti e il programma usa dei default. 

 

Event.Name = deve avere lo stesso nome del file ocad dei percorsi (dovrebbe prenderlo comunque in 

automatico) 

Event.Stations = numero di stazioni 

Event.tasks = numero di quesiti per ogni stazione (questo è il default per tutte le stazioni – se una stazione ha 

un numero diverso di quesiti rispetto a questo default si può indicare il nuovo valore editando la singola 

stazione nella sezione Station 1.Tasks) 

Event.Zero = Yes nel caso di TempO – No nel caso di PreO 

Event.Flags = numero di lanterne per ogni stazione (questo è il default per tutte le stazioni – se una stazione ha 

un numero diverso di quesiti rispetto a questo default si può indicare il nuovo valore editando la singola 

stazione nella sezione Station 1.Flags) 

 

Source.Mode = STAT (in OCAD un percorso per ogni stazione) - l'alternativa TASKS prevede di dover creare 

in OCAD un percorso per ogni quesito e risulta più complicato. 

 

Target = per una configurazione standard con due mappe A5 impaginate su foglio A4 lasciare 

Target.Canvas=A5 e Target.Sheet=A4Tiled  

Text.Station = Stazione  (oppure lasciare il default Station se la gara è internazionale) 

Text.Tasks = Quesiti  (oppure lasciare il default Tasks) 

Text.Limit = Tempo Limite  (oppure lasciare il default Limit) 

 

Map.Segment= variare il default 60 (mm) per avere un segmento di mappa più o meno grande 

                           (IOF permette i valori tra 50 e 120) 

Map.Shape= variare il default circle con square se si ha bisogno di mappa quadrata (che permette di 

visualizzare un'area piú grande) 

 

OrderTabs.Cover=Yes (per far comparire il numero 0 sulla copertina delle stazioni) 

 

Station1.Min Angle=     indicare l'angolo (in gradi ) verso cui guarda la sedia della stazione; inserire un valore 

per ogni stazione). Se la sedia guarda a NORD inserire 0, se guarda a SUD inserire 180 etc. etc. 

Se usato da solo Min Angle è l'angolo medio tra ALPHA e FOXTROT– se usato insieme a Max Angle invece è 

l'angolo della lanterna ALPHA (e Max Angle l'angolo della lanterna FOXTROT). E' possibile omettere tale 

valore e far effettuare la rotazione automatica da TiM se nel file percorsi sono presenti degli oggetti che 

rappresentano il punto di vista (sedia) e le lanterne posate (vedi paragrafi successivi). 

 

CREAZIONE FILE DI STAMPA 

Cliccare are File-> Make Vector Maps 

e selezionare le stazioni per cui si vogliono creare i file di stampa (in genere tutte le stazioni). 

Nella cartella di installazione vengono quindi creati dei file SVG map-1.0.svg map-1.1.svg etc. etc. e dei file 

che useremo per la stampa prn-1.0-1.1.svg prn-1.2-1.3.svg etc. etc. 

Il modo più semplice per stamparli è aprirli in Chrome e stamparli come pdf (Tasto destro -> Stampa e invece 

della stampante scegliere Salva come Pdf) tenendo tutti margini a ZERO e la scala a 100%. 
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Ripetere l'operazione per ogni file .svg e alla fine avremo in nostri .pdf pronti per la stampa. 

 

È possibile configurare TiM in modo da stampare direttamente pdf usando il software Inkscape (ciò richiede 

l'installazione sul PC di Inkscape e il controllo che questa configurazione in TiM sia giusta. 

System.InkscapePath = C:\Program Files\Inkscape\ 

In questo caso il comando da lanciare é File-> Make Vector Maps dove possiamo scegliere l'output tra vari 

formati, ad esempio pdf (per la stampa delle mappe) o png (per pubblicare online ad esempio per un TempO 

virtuale). 

 

SALVATAGGIO 

Prima di uscire da TiM ricordarsi di salvare il file perché il salvataggio non è automatico (se si prova a 

chiuderlo senza salvare esce un alert che può trarre in inganno). 

 

PROBLEMA CON I RETINI 

Possono capitare problemi di rendering della mappa nei file SVG per i simboli fatti con retini (ad esempio 

semiaperto – rigato verde). Una possibile soluzione è agire direttamente in OCAD e trasformare gli oggetti 

semiaperti o rigati in oggetti grafici mediante il comando To Graphics (e poi lavorare con simboli e colori) 

 

 

DESCRIZIONI PUNTO TESTUALI 

Non sono previste 

 

CHAIR FLAG ZERO 

E' possibile inserire nel file ocad dei simboli speciali per la sedia, la 

lanterna e la lanterna zero (come aiuto nella posa e per inserirli nel 

foglio delle soluzioni) 

In ocad creare i simboli che si chiamano ad esempio: 

21.1 chair 

21.2 flag 

21.3 false - simbolo per differenziare le lanterne sbagliate (quelle che non sono risposta di alcun quesito) 

                   si può omettere – mettendo tutte le lanterne come 21.2 flag 

21.4 zero 

e posizionarli nelle varie piazzole. 

 

Dalla versione di TiM 4.1.10 questi simboli devono essere tutti CourseSetting symbols di tipo FINISH, 

 

E' importante che il codice di questi simboli sia maggiore di 20 (valore richiesto da TiM). 

Per fare in modo che TiM li elimini dalle stampe di gara bisogna configurare questi campi in TiM: 

Source.Chair=  21.1 

Source.Correct Flag=  21.2 

Source.False Flag=  21.3 

Source.Zero=  21.4 
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ATTENZIONE:  

- Assicurarsi che i simboli di sedia, lanterna e zero siano costruiti con un solo colore (e non con un colore 

e uno sfondo di un altro colore – ad esempio è ok un simbolo di lanternina magenta ma il bianco deve 

essere lasciato trasparente e non di colore bianco)  

- Assicurarsi che i simboli circolari siano costruiti come linea circolare (in ocad CIRCLE con due parametri: 

diametro e spessore linea) e non come area (in ocad DOT con unico parametro diametro). 

Quindi per il pallino pieno magenta evitare di costruire un DOT di 0.50 mm di diametro ma costruire un 

CIRCLE di 0.30 mm di diametro con spessore linea 0.29 mm (si avrà lo stesso risultato – ma nel caso del DOT 

TiM va in errore). 

 

 

RISPOSTE ESATTE 

Le risposte esatte dei quesiti da far comparire sulle soluzioni si possono configurare in due modi alternativi:  

- In Ocad creando dei simboli di descrizione punto A B C D E F Z con codici ad esempio 19.21 19.22 etc etc 

  configurati in modo che possano essere inseriti nella colonna H di ogni punto di controllo 

  (edit symbol e mettere la croce sulla colonna H) 

In TiM bisogna configurare il campo Source.Answers= 19.21 in modo che le lettere non compaiano nei   

quesiti ma solo nelle soluzioni (basta settare il primo simbolo 19.21 per la A, gli altri sono configurati di 

conseguenza automaticamente). 

- Oppure in TiM in ogni stazione nel campo Answers come stringa di testo (ad es. DZBZA) Station1.Answers 

 

SOLUZIONI e ROTAZIONE AUTOMATICA (istruzioni valide per TiM versione 4.1.10) 

In TiM è possibile produrre automaticamente il foglio delle soluzioni e la rotazione automatica delle piazzole 

(senza inserire i gradi nei campi Station1.Min Angle). 

Bisogna quindi avere in Ocad i simboli di chair flag zero (falseflags) tutti come CourseSetting symbols di tipo 

FINISH, posizionare dei punti di controllo con questi simboli (potremmo chiamarli 101 102, ma nulla vieta di 

chiamarli f31 f32 etc etc) nel posto corretto e inserirli come punti di controllo fittizi nel percorso della stazione 

voluta (insieme a partenza arrivo e punti normali). 

 

E' possibile inserire nelle soluzioni accanto al pallino di ogni lanterna il nome della lanterna stessa (A B C etc 

etc). Per fare questo costruire in OCAD un simbolo di 'A' con codice 791.1, un simbolo di 'B' con codice 791.2 

etc. etc. e in TiM cofigurare il campo Source.Letters=  791 (basta un campo solo – le altre lettere verranno 
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trovate di conseguenza se i loro simboli hanno numeri che iniziano per 791 e proseguono dopo il punto con ad 

esempio 791.1 791.2 etc). 

Anche questi simboli sono da configurare come CourseSetting symbols di tipo FINISH e da inserire nel 

percorso voluto. 

 

A questo punto ad esempio il percorso 5 che rappresenta la stazione 5 potrebbe essere composta da questi punti 

(il numero dato ai punti i controllo/altri simboli è libero, questa è una possibile notazione per non fare 

confusione): 

-punto di controllo chiamato 51 

-punto di controllo chiamato 52 

-punto di controllo chiamato 53 

-punto di controllo chiamato 54 

-punto di controllo chiamato 55 

-punto di vista chiamato v5 

-lanterna A chiamata f51 

-lanterna B chiamata f52 

-lanterna C chiamata f53 

-lanterna D chiamata f54 

-lanterna E chiamata f55 

-lanterna F chiamata f56 

-lanterna Z chiamata z51 

-lanterna Z chiamata z52 (in questa piazzola ci sono solo due Z) 

- lettera A chiamata l51 

- lettera B chiamata l52 

- lettera C chiamata l53 

- lettera D chiamata l54 

- lettera E chiamata l55 

- lettera F chiamata l56 

 

arrivando così ad avere per questo percorso 20 punti di controllo. 

Cercare di lavorare puliti e non fare pasticci, cioè inserire i punti senza troppe cancellazioni, cambiamenti di 

numero (nome del punto) o undo-redo perché alcune versioni di ocad fanno le bizze con i percorsi e lasciano a 

schermo (e nelle esportazioni) delle visualizzazioni di oggetti cancellati. Nel caso succeda individuare quale 

punto di controllo crea il problema, eliminarlo dal percorso, cancellarlo e riposizionarlo (ovviamente 

rimettendo anche descrizione punto). 

 

Ricapitolando per avere le soluzioni: 

oltre ai punti di controllo con la loro descrizione punto, partenza e descrizione punto per ogni stazione bisogna 

effettuare le seguenti operazioni 

- mettere in mappa il punto di vista 

- mettere in mappa le posizioni delle singole lanterne (ad es. pallini magenta) 

- mettere in mappa le lettere delle lanterne accanto ai pallini delle lanterne  

- mettere in mappa le posizioni delle lanterne ZERO 

- inserire nel percorso tutti i precedenti oggetti (punto di vista – lanterne – lettere – zero) 

- in modalità PREVIEW controllare che i numeri d'ordine dei quesiti (1 2 3 4 5) siano posizionati accanto al 

cerchio giusto, altrimenti spostarli 

- eventualmente inserire per ogni punto di controllo nella colonna H la risposta esatta (oppure farlo in TiM) 

 

Si ricorda che all'indirizzo www.remmaps.it/trailo/dwnld/sample_ocad_cfg.zip è possibile scaricare un sample 

http://www.remmaps.it/trailo/dwnld/sample_ocad_cfg.zip
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funzionante (testato con TiM versione 4.1.10) con tutte le configurazioni e i simboli descritti fino ad ora. 

 

STAMPA SOLUZIONI 
Dopo aver esportato SVG e xml (come già fatto per creare le stampe delle mappe di gara) lanciare il comando 

Make-> Make Vector Solutions oppure Make-> Make Raster Solutions 

Per una piazzola da 6 quesiti con mappe al 4000 in genere un buon layout per le soluzioni è A4 verticale con le 

mappe al 2000. 

Si possono configurare scala, margini e altre cose in TiM nella sezione Solutions. 
 
FAQ 

(direttamente prese da http://tim.yq.cz/ ) 
- Non vedo la mappa, solo i cerchi dei punti di controllo 

Controlla che nel file dei percorsi la mappa di sfondo sia visibile (potrebbe essere a vivibilità 0%) e soprattutto 

che nel file della mappa sia selezionato View-> Normal Mode  

- Non vedo una parte della descrizione punto 

Controlla che l'esportazione SVG contenga tutta l'area della descrizione punto 

- Non vedo nei file di output in TiM una recente modifica nella mappa (STAT mode) 

Controlla di aver ri-esportato il file XML dopo la modifica 

- Nei file di stampa il verde sembra fosforescente 

 Aumenta il valore del nero nel colore verde nel file della mappa 

 (in Symbol – Colors se i valori CYMK del Verde sono 76 0 91 0 prova a mettere 76 0 91 15) 

 ATTENZIONE che nella mappa ci potrebbero essere molti verdi diversi (ad es. un verde per i cespugli 

puntiformi, un verde per il rigato, un verde per le aree) – cambiarli tutti! 
 

 

http://tim.yq.cz/
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2) ANT — Answer'N'Time Recorder 

APP  PER  CRONOMETRARE I CONCORRENTI ALLE STAZIONI TEMP-O 

(CON CELLULARE O TABLET) 

sito> http://ant.yq.cz/  

requisiti> Cellulare con ANDROID (no Iphone) 

(funziona con Android dalla versione con API 14 - Ice Cream Sandwich 4.0.1) 

 

ANT è una app che si installa facilmente su tutti i dispositivi android. È possibile configurare un server per 

ricevere i dati che mandano i singoli cronometristi (che in questo caso devo avere connessione dati) e inserirli 

automaticamente in Oribos (oppure a mano su file excel). 

 

Sul sito è presente un forum in cui condividere esperienze e problemi. Il creatore del software Libor Forst 

(forst@ms.mff.cuni.cz) è sempre pronto ad aiutare in caso di problemi. 

 

 

INSTALLARE E USARE LA APP 

I cronometristi dal loro cellulare devono scaricare 

la app alla pagina http://ant.yq.cz/ tramite l'icona 

in alto a destra nel sito (vedi foto, non si trova su 

Google Play) 

 

Essendo un link diretto (e non Google Play) 

bisogna dare il permesso di installare la app da 

fonti sconosciute. Android in genere permette di 

dare questo permesso solo per l'installazione 

corrente. 

 

Una volta installata la app andare in EVENT per 

caricare il file INI di configurazione. 

Cliccare l'ingranaggio accanto a  Configuration 

File, scegliere dalla tendina Web server (HTTP) e 

quindi in http: digitare l'indirizzo web fornito 

dall'organizzatore della gara per il file INI. 

Sarà da digitare qualcosa del tipo: 

//www.remmaps.it/trailo/sankorrado/ini.txt  

(ricordarsi di digitare anche gli slash iniziali) 

Cliccare DONE 

Cliccare ancora DONE 

 

Configuration file not loaded! Shall I load it?   YES 

 

Se il file viene caricato correttamente ANT mostra questo messaggio: Configuration file loaded. 

 

Per semplicità, sempre in EVENT, si consiglia di deselezionare tutte le impostazioni delle schermate per 

l'accoglienza del concorrente (Siedi – Cartellino – Loose or bound – Point or speak etc. etc.) 

 

Andare in STATIONS e selezionare la stazione per cui si farà il cronometrista (ad esempio la 3) cliccando su 

NO, che diventerà YES con sfondo verde 

http://ant.yq.cz/
http://ant.yq.cz/


 
                        

 

 

 

Presidenza e Segreteria Generale: Via della Malpensada,84 - 38123 TRENTO 

Telefono +39 0461-231380 Web: www.fiso.it - E-mail: info@fiso.it 

P.IVA 00853510220 - C.F. 80023420229 
  
 

 

Cliccare DONE 

 

A questo punto appare la schermata dove scegliere il pettorale del concorrente.  

Digitare il numero del concorrente con i numeri presenti sulla schermata – ad esempio 44 (vedi *) 

Nella tendina apparirà il nome del concorrente 44 Murer Lucia 

Confermare cliccando sul nome  

Cliccare sulla freccia verso destra 

 

La app ruota di 90 gradi la schermata e anche voi girate il telefono (ANT propone vista orizzontale per avere 

piú spazio sullo schermo) 

Cliccare sull'icona della montagna 

Quando si è pronti a fare partire il tempo cliccare su NOW! 

Cliccare sulle lettere mentre il concorrente risponde 

All'ultima risposta non bisogna fermare il tempo ma la app prende il tempo di quando è stata cliccata l'ultima 

risposta (A questo punto la schermata propone un cronometro che continua ad andare, nel caso si fosse fermato 

per errore, ma la app ha registrato il tempo in ogni caso) 

Cliccare sul quadrato nero 

Nella successiva schermata, se previsto dall'organizzatore, si possono dire sl concorrente le risposte e il tempo 

impiegato. 

Nella stessa schermata è possibile accedere alla modalità EDIT in cui si possono modificare le risposte o il 

tempo registrato. 

Dopo aver fatto le eventuali modifiche si ritorna a questa schermata e si puó cliccare SAVE 

E poi OK 

A seconda di come è configurato il file INI ogni tot concorrenti la app chiede di inviare i dati.  

Rispondere YES 

Dovrebbe apparire un messaggio 'File inviato con successo' 

Chiudere il messaggio con la X nera in basso a sinistra 

(A questo punto può capitare un messaggio di errore – ignorarlo – se è uscita la schermata precedente l'invio è 

andata a buon fine) 

 

Terminati i concorrenti è possibile che gli ultimi n concorrenti non sono stati inviati al server (ad esempio se 

l'invio viene fatto ogni 10 concorrenti e ne sono arrivati solo 6). Per inviare anche questi ultimi andare in 

Results e cliccare sulla freccia verde sulla destra. 

 

*Nella schermata di scelta dei concorrenti è anche possibile digitare il cognome del concorrente (con la tastiera 

dei android che appare). 

In questa schermata ci sono tre tasti: 

la X serve per cancellare numeri eventualmente digitati 

I due filtri servono solo se si digitano i numeri con i tasti presenti in questa schermata (non con la tastiera dei 

android che appare). 

Nel caso si digiti '1' il filtro pieno mostra tutti i concorrenti che hanno nel loro pettorale il numero 1 (ad 

esempio 10 11 105 etc etc) mentre il filtro vuoto mostra tutti i concorrenti che hanno nel loro pettorale il 

numero 1 e non sono ancora transitati da questa stazione. 

 

 

CONFIGURARE LA APP 

L'organizzatore delle gare deve preparare (con qualsiasi editor di testo) il file INI da caricare su un webserver e 

far caricare ai cronometristi in ANT dando loro l'indirizzo web (come abbiamo visto sopra). 

Un esempio di file INI si trova all'indirizzo 
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http://www.remmaps.it/trailo/sankorrado/ini.txt  

 

Questo sotto è un file INI di esempio per una gara con 1 stazione, con 3 concorrenti, che manda i risultati al 

server remmaps ogni 5 concorrenti. 

Da notare che la lista di partenza deve essere nel file INI (in questo caso con i 3 soli concorrenti). 

I due numeri che precedono il nome sono ID e pettorale, per evitare problemi meglio che siano uguali. Se si 

usa Oribos per l'importazione dei risultati devono coincidere con il campo Pettorale di Oribos. 

 
; ANT Configuration (INI) file sample 

; 

; Except the station data, all configuration items are optional. 

; If this file contains non-ASCII characters, they must be encoded in utf-8, 

;   unless this file name contains the charset name as a substring, e.g.: 

;   ant-windows-1250-myevent.ini, ant.iso-8859-1.ini. 

 

[Event] 

; Event ID (alphanumeric chars, underscore) 

ID=piacenza 

Name= Piacenza TempO 

; Event date (yymmdd or yyyy-mm-dd) 

Date=2019-3-3 

 

[IniFile] 

; For easier downloading of future INI file versions (if needed). 

; If the URL contains the event ID, a username and/or password this data 

; can be entered separately in app and substituted for placeholders 

; $event_ID, $username and/or $password. 

;URL=https://preoresultat.se/ANT/download.php?c_id=$event_id 

URL=http://www.remmaps.it/trailo/sankorrado/ini.txt 

 

[Startlist] 

; For easier downloading if startlist used and not included here 

; URL=http://www.remmaps.it/trailo/m9nza/lista.txt 

; Startlist file charset (windows-1250/2, iso-8859-1/2, default: utf-8) 

Charset=utf-8 

; 

; You can include the startlist directly here - one line per person in form 

; ID-number;bib-number;name 

; The ID-number idenitifies the competitor, 

;   you can use value of zero if not required. 

; The bib-number field can be left empty. 

; 101;101;Libor Forst 

1;1;Montefiori Maria Grazia 

2;2;Valpiani Davide 

3;3;Volponi Giovanni 

 

[Results] 

; If results upload used 

;URL=https://preoresultat.se/ANT/download.php?user=$username&pass=$password 

;URL=http://ant.yq.cz/upload-results.cgi 

URL=http://www.remmaps.it/trailo/sankorrado/carica.php 

; Result file charset (windows-1250/2, iso-8859-1/2, default: utf-8) 

Charset=utf-8 

; 

; On-line upload configuration: 

; 0: manual 

http://www.remmaps.it/trailo/sankorrado/ini.txt
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; 1: automatic - sending after every competitor 

; N: batch - sending after N competitors 

Count=5 

; 

; On-line upload content: whole file or just unsent data 

Mode=full 

;Mode=incremental 

 

[Station 1] 

Tasks=5 

Flags=6 

Zero=yes 

Limit=150 

Warn=20 

 

CONFIGURARE IL SERVER 

Per configurare il server bisogna disporre di uno spazio web in cui è possibile uploadare files (e scrivere 

permessi sulle cartelle). 

In questo tutorial è mostrato un esempio sul webserver di Aruba (server Windows), sul server remmaps.it 

(disponibile gratuitamente se l'organizzatore non dispone di un server, contattare Remo Madella). 

 

Creare sul server una cartella con i permessi di scrittura. 

 

In Aruba andare in Pannello di controllo – Permission Manager e settare i permessi della cartella (e tutti i file 

contenuti) su READ/EXECUTE-WRITE   (invece del default READ/EXECUTE) 

 

 

Nella cartella sul server devono essere caricati 4 files: 

index.php 

up.php 

carica.php 

ini.txt (che abbiamo visto precedentemente) 

(Aruba non permette di caricare un file con estensione .ini quindi il nostro file di configurazione INI si 

chiamerà ini.txt e non ant.ini) 

 

Più sotto trovate i testi dei file da caricare (i php sono stati scritti con l'aiuto di Andrea Foschian e Renato 

Bettin). 

 

Nel file di configurazione INI di ANT nella sezione [RESULTS] scrivere il percorso dove si trova il file 

carica.php 

URL=http://www.remmaps.it/trailo/sankorrado/carica.php 

 

Nel file index.php di esempio è stata configurata una password. 

 

Il file index.php è il file a cui accedere durante la gara per 1)visualizzare il file INI 2)caricare sul server un 

nuovo file INI 3)visualizzare le risposte che arrivano dalle stazioni (vedi foto). 

Per questo esempio basta andare su qualsiasi browser e digitare  www.remmaps.it/trailo/sankorrado 

http://www.remmaps.it/trailo/sankorrado/carica.php
http://www.remmaps.it/trailo/sankorrado
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(la password serve per proteggere la visualizzazione di questa pagina – in teoria se l'indirizzo web è 

sconosciuto ai concorrenti la password potrebbe anche non servire) 

Per salvare i file di testo che arrivano dalle stazioni cliccare su ogni file con tasto destro e salvare il file .txt in 

locale sul proprio PC (per poi processare le risposte con Oribos o file Excel). 

 

Per caricare sul server il file ini.txt (ad esempio per aggiornare le liste di partenza prima di far caricare ai 

cronometristi il file INI) usare i bottoni Choose file  - Submit.  

(I files carica.php index.php e up.php invece si possono caricare solo con il proprio webserver/ftp) 
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Index.php 
<?php 

// ------------------------- 

$password = 'sankorrado'; 

// ------------------------- 

 

$pwd = isset($_GET['pwd']) ? $_GET['pwd'] : false; 

if (!$pwd || $pwd != $password) { 

  ?> 

<form method="get" action="<?php echo $_SERVER['PHPSELF']; ?>"> 

<table border="0" cellspacing="0" cellpadding="10"> 

<?php if ($pwd !== false): ?><tr class="errore"><td colspan="3">La password inserita 

non è corretta!</td></tr><?php endif; ?> 

<tr> 

  <td>Password</td> 

  <td><input type="password" name="pwd" style="width: 180px;"/></td> 

  <td><input type="submit" value="Entra"/></td> 

</tr> 

</table> 

</form>   

  <?php   

}else{ 

  ?> 

<form action="up.php" method="post" 

enctype="multipart/form-data" target="_blank"> 

              <label for="file"></label> 

              <div align="left"> 

                <label for="label"><span >Upload ini.txt:</span></label> 

                <span > 

                <input name="file" type="file" id="file" /> 

                </span> 

                <input name="submit" type="submit" value="Submit" /> 

              </div> 

</form> 

<?php 

//Imposto la directory da leggere 

$directory = getcwd().'\\'; 

if (is_dir($directory)) { 

//Apro l'oggetto directory 

if ($directory_handle = opendir($directory)) { 

//Scorro l'oggetto fino a quando non è termnato cioè false 

while (($file = readdir($directory_handle)) !== false) { 

//Se l'elemento trovato è  un txt lo visualizzo 

$path_i = pathinfo($file); 

 

if($path_i['extension'] == 'txt') 

echo "<a href='$file'>$file</a><br/>"; 

} 

//Chiudo la lettura della directory. 

closedir($directory_handle); 

} 

} 

?>  

  <?php   

} 

?> 
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Up.php 
<?php 

if (($_FILES["file"]["type"] == "text/plain") 

&& ($_FILES["file"]["size"] < 2000000)) 

  { 

  if ($_FILES["file"]["error"] > 0) 

    { 

    echo "Return Code: " . $_FILES["file"]["error"] . "<br />"; 

    } 

  else 

    { 

    echo "Upload: " . $_FILES["file"]["name"] . "<br />"; 

    echo "Type: " . $_FILES["file"]["type"] . "<br />"; 

    echo "Size: " . ($_FILES["file"]["size"] / 1024) . " Kb<br />"; 

    //echo "Temp file: " . $_FILES["file"]["tmp_name"] . "<br />"; 

 

      move_uploaded_file($_FILES["file"]["tmp_name"], 

      $_FILES["file"]["name"]); 

    //echo "Stored in: " .  $_FILES["file"]["name"]; 

 

    } 

  } 

else 

  { 

  echo "Invalid file"; 

  } 

?> 

</p> 
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Carica.php 
<?php 

header('Content-Type:text/plain'); 

 

$target_dir = "./"; 

$joinfile = "join.txt"; 

 

 

$namepost = "RESULTS";  

 

  

$target_file = $target_dir . basename($_FILES[$namepost]["name"]); 

 

    if (move_uploaded_file($_FILES[$namepost]["tmp_name"], $target_file))  

 { 

$files = scandir($target_dir); 

$fpJoin = fopen($joinfile , 'w'); 

 

// unione dei file .txt 

foreach ( $files as $nomefile) 

{ 

if ( strlen($nomefile) > 10 && substr_compare($nomefile, ".txt", strlen($nomefile) - 

4, 4) === 0) 

{  

$filecont = file_get_contents($target_dir . $nomefile); 

fwrite($fpJoin, $filecont);   

} 

} 

 

fclose($fpJoin); 

 

echo "ANT: OK salvataggio riuscito";  

    }  

 else  

 { 

  

 echo "ANT: ER errore di invio";  

     

} 

?> 
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3) Oribos 

SOFTWARE PER GESTIRE ISCRIZIONI E CLASSIFICHE (SIA PRE-O CHE TEMP-O)  

sito> https://www.bostek.it  

 

Oribos è un software che si installa su PC con Windows (no Mac). E' gratuito nella versione Professional  

(limite di 400 atleti – serve registrazione) e nella versione Free (limite di 100 atleti – senza registrazione). 

 

Nell'HELP del programma è disponibile una sezione Trail-O a cui fare riferimento in aggiunta a questo tutorial. 

 

Scaricare Oribos da https://www.bostek.it/Download.aspx  

Se si desidera la versione Professional (400 atleti) registrarsi su https://www.bostek.it/Registrazione.aspx  

Installare il programma sul PC. 

 

File>Nuovo 

In Tipo Gara selezionare Trail-O 

In Gara Trail-O selezionare Pre-O, Temp-O o Staffetta 

 

In Pre-Gara > Percorsi e Categorie 

'Aggiungi' nuovo percorso che chiameremo Elite 

 

In Pre-Gara > Sequenza Punti 

aggiungere i vari punti di controllo con il tasto VERDE + 

nella colonna 'corretto' digitare la risposta giusta di quel punto 

nel caso di Pre-O sarà una lettera (Z) 

nel caso di Temp-O sarà una stringa (AZZCE) che rappresenta le risposte in ordine dei quesiti della stazione 

È possibile configurare il range delle risposte (AE per PRE-O, AF per Temp-O) e un flag in cui dire se è 

presente la risposta Z (sì per Temp-O e Pre-O, no per punto a tempo del Pre-O) 

Al termine cliccare 'Esci' 

 

Per importare gli iscritti dal sito FISO (serve connessione a internet) utilizzare il comando 

Importa>Fiso>Iscrizioni (internet) 

In 'Utente' inserire il codice della società organizzatrice - ad esempio per Pol.Masi 0221  (221 senza zero non 

funziona) oppure scegliere la società da una lista cliccando sui tre puntini 

'Recupera Gara' 

Selezionare la gara desiderata e cliccare 'Importa' 

 

Prepara Griglia di Partenza in Pre-Gara>Prepara Griglie 

 

Per le stazioni Temp-O gestite con ANT è possibile esportare la griglia di partenza in formato testo in modo da 

copiarla nel file INI con il comando: 

Esporta> ANT Trail-O > Griglia 

con la accortezza di trasformare il formato in uscita da Oribos in quello preferito da ANT 

da     1 Montefiori Maria Grazia 

a       1;1;Montefiori Maria Grazia 

 

Ricordarsi di dare i comandi: 

Gara > Chiudi Pre-Gara 

Gara > Partenza 

altrimenti non è possibile continuare 

https://www.bostek.it/
https://www.bostek.it/Download.aspx
https://www.bostek.it/Registrazione.aspx
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STAZIONI A TEMPO 

E' possibile importare i file di testo prodotti da ANT (vedi sezione dedicata) in modo manuale o automatico 

 

IMPORTAZIONE MANUALE 

Importa>ANT Trail-O>File 

Selezionare (anche tutti e 6 insieme) i file di testo scaricati precedentemente  

Le risposte vanno automaticamente in Oribos 

 

IMPORTAZIONE AUTOMATICA 

Importa>ANT Trail-O>Automatica 

Impostare l'indirizzo da cui si importano le risposte nel primo 

bottone: 

per la configurazione su server remmaps il nome del file è  

http://www.remmaps.it/trailo/sankorrado/join.txt  

(questo file join.txt è creato dal file carica.php che compone 

insieme i 6 file di testo provenienti dalle piazzole). 

Far partire l'importazione con l'ultimo bottone – ricaricare se 

per qualche motivo le risposte non arrivano. 

Automaticamente Oribos popola le risposte. 

 

 

È possibile visualizzare la classifica estesa (con le risposte alle singole stazioni) in: 

Stampe>Stampe Trail-O>Classifica estesa  

(nel caso si vogliano classifiche parziali prima che i concorrenti completino tutte le stazioni bisogna fare in 

modo che i concorrenti siano CLASSIFICATI – un 

modo semplice è andare in Pre-Gara>Modifiche Rapide, 

selezionare Categoria OPEN ELITE tasto FILTRO, 

 

 

 

'Seleziona Tutti' e assegnare la Situazione CL –  

Classificato con il tasto TABELLA) 

 

 

 

 

INSERIMENTO MANUALE RISPOSTE 

In ogni caso è sempre possibile inserire manualmente le 

risposte andando in Gara>Inserimento Tempi 

Si sceglie il pettorale del concorrente e si agisce sulla 

tabella in foto, inserendo manualmente tempi e risposte.  

La casella gialla permette un inserimento rapido dei 

risultati scrivendo per ogni stazione prima la risposta (o 

la stringa) e dando invio (o freccia blu) poi il tempo e 

dando invio. 

Nel caso di Pre-O (solo risposta), oltre che digitando con 

la tastiera è possibile cliccare sul bottone della lettera 

corrispondente alla risposta. 

 

http://www.remmaps.it/trailo/sankorrado/join.txt
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SPORTIDENT 

Per l'utilizzo di Sportident bisogna configurare ogni punto di controllo dicendo quali stazioni (ad es. 32 34 36) 

sono associate alle varie lettere A B C Z. 

Scegliere 'Sportident' in Pre-Gara>Informazioni> Punzonatura e nella schermata dei Percorsi (Pre-

Gara>Sequenza Punti) compare una tabella supplementare dove indicheremo i codici Sportident. 

Per la lettura dei chip si utilizzerà Oribos Reader. 
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Changelog 
 

Versione Giugno 2019: Prima versione 

Versione Giugno 2020: Aggiunto capitolo su Soluzioni TiM e altre modifiche minori 

 


